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Chapter 1: About this document

Outline

This document contains necessary information amtkegjoes for the creation of custom
themes that allow for customization of “XMB” icomsthin the “PSP” system software.
Specifically, it contains:
- Types of icons that can be customized
Image sizes and formats
Non-icon required data
Other information



Chapter 2: Customizable Data

Data that can be customized is described below.

Category Row Icons (Horizontal Row)

Category Row Icons are icons that represent thiedrtally-oriented categories.

7r3 1545
> B § S
FT=zro —

AEY=AF rwD

- TAEE 4AtAMB

The following 8 Category Row Icons can be specified
Category | Notes

Network

Game

TV Only available on Japanese PSP-2000 models

Video

Music

Photo

Settings

Default This is for representing new icons that may be
introduced in future updates.
If only Default is specified, all icons will show as this
Default icon.

First Level Icons (Vertical Column First Level)

First Level Icons are the icons that display veiticwhen a Category Row Icon is
selected.



The following First Level Icons can be specified.
Category First Level
Network | Online Manual
Remote Play
RSS Channel
Internet Browser
Game Game Sharing
Save Data Management
"UMD" *
"PSP" Update
"Memory Stick" *
Video "UMD" *
"Memory Stick" *
Music "UMD" *
"Memory Stick" *
Photo Camera
"Memory Stick" *
Settings | Network Update
USB Connection
Video Settings
Photo Settings
System Settings
Theme Settings
Date and Time Settings
Power Save Settings
External Display Settings (PSP-2000 only)
Sound Settings
Security Settings
RSS Channel Settings
Network Settings
Other Default
* Only one set of “UMD” and “Memory Stick” iconsaa be customized; they will be the
same for all categories.




Second Level Icons (Vertical Column Second Level)

Second Level Icons are the vertically-oriented gtrat are displayed to the right when a
First Level Icon is selected. Custom Themes allomnSecond Level Icons for the
Settings category to be customized (Wrench icadhenmage below)

Wallpaper

The wallpaper that is used as a background capdmfied.

Theme Color

Of the 12 theme colors that can be specified itirggt -> Theme Settings -> Theme, one
color that best matches the Custom Theme can lo#isge
Not specifying a color is also possible.

Preview

The icon and image that are used when selectinGaiséom Theme can be specified.



List of Customizable Icons

Category

Network @

The following icons can be customized.
First
Level

Display Name

Online Manual

Remote Play

RSS Channel

Internet Browser

Game ™

Game Sharing

Save Data
Management

"UMD"

"PSP" Update

"Memory Stick"

"UMD"

"Memory Stick"

"UMD"

"Memory Stick"

Photo £

Camera

"Memory Stick"

Settings =

Network Update

USB Connection

Video Settings

Photo Settings

System Settings

Theme Settings

Date and Time Settings

Power Save Settings

External Display
Settings

Sound Settings

Security Settings

RSS Channel Settings
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Network Settings




Chapter 3: Image Sizes and Formats

The section contains detailed information on thagmsizes and formats used in Custom
Themes.

Category Row Icon (Horizontal Row)

The image size and format used for Category Rowdd® described below.

Image Size 64 x 48 pixels

Image Format 256-color 32bit CLUT (with Alpha channel)
PNG/TGA/GIM file

Alpha Channe
RGE T

48 pixel

64 pixel

First Level Icons (Vertical Column First Level)

The image size and format used for First Level $cisrdescribed below.

Image Size Icon Body 48 x 48 pixels
Icon Focus 64 x 64 pixels

Image Format 256-color 32bit CLUT (with Alpha chaihn
PNG/TGA/GIM file

Icon Body

RGE Alpha Channe
48 pixel *
48 pixel



Icon Focus

RGB

Alpha Channe

64 pixel

64 pixel

Second Level Icons (Vertical Column Second Level)

The image size and format used for Second Leveisit®described below.

Image Size

Icon Body

32 x 32 pixels

Icon Focus

48 x 48 pixels

Image Format

256-color 32bit CLUT (with Alpha chafhn
PNG/TGA/GIM file

Icon Body

RGB

32 pixel

32 pixel

Icon Focus

RGE

Alpha Channe

48 pixel

48 pixel

Wallpaper

Alpha Chinne

*

The image size and format used for Wallpaper isritesd below.

Image Size

480 x 272 pixels

Image Format 24-bit color RLE uncompresse
Bitmap file




272 pixel

Theme Color

480 pinel

The specifiable theme colors are below.

Theme

Color Number
| By Month 0
|1
o ]2
| 3
| 4
| 5
| 6
- 7
| 8
| 9
- 10
- 11
L 12

Preview

The image size and format used for the Previevwdaseribed below.

Image Size | Preview Icon | 16 x 16 pixels
Preview Image 300 x 170 pixels
Image Format Preview Icon | PNG/TGA/GIM file

256-color 32-bit CLUT (with Alpha channe

Preview Image

24-bit color RLE uncompressed

Bitmap file

-11 -



Preview Icon

RGB Alpha Channe

16 pixel

16 pixel

Preview Image

170 pixel

300 pixel

-12 -



Chapter 4: Notes about icon creation

This chapter lists some points of warning for icoeation.

Icon data

When creating icons, avoid creating icons thatardg one color. With the Wallpaper
Setting functionality, users are able to specisirtiown wallpapers. Use gradations or
borders to distinguish the icons from customizetipapers.

For example, if the single-color icon data belowsgd on a white background, the icon
will disappear.

Icon data When displayed on white background

In such cases, the icons will be easier to semdajions or outlines are used.

-13 -



Icon data When displayed on white background

ala
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Also, if using the icon designs found in the defayistem software, try to avoid changing
their original shapes or meanings.

Focus Data

When creating Icon Data, please also create Foates for when each icon is selected on
the menu. The System Software’s standard themédhfaxus setup such that icons will
glow white when they are selected. If Focus Dataested in the same fashion, it will be
easier for users to recognize that particular idenge been focused.

As an example, the creation of Focus Data usingté®hop” is described on the
following page.

-14 -



How To Make PSP lcons

T

Add the slpha channed snd cogy- paste ICON on i

Gausshn Blur: G, Opeel

[Eddit » Delate]
Dwdete fust selection on AGE channehy
Copy RGE image 1o the alpha channel
Paint RGB leyers all whita

Duplicate the layer bwice. i, - [Layer > Flatten inagae]
(1o inorease the convbrast) - Merge all lyers,

- 15 -



Chapter 5: Custom Theme Settings

This section describes how to apply a Custom Themthe PSP system.

Custom Theme Settings are performed using Thentm@ebption in the Settings
category.

B/17 14:38 {m]

AU
AS— PAO0OTFHAVERELE

On the right side of the screen, Preview Icons@iginal” and theme files stored inside
the “Memory Stick”s \PSP\THEME folder will be dilgyed. “Original” is the standard
PSP theme.

The Preview Image of the selected Custom Themebwillisplayed in the middle of the
screen.

-16 -



(0 Cookies

Choose the Custom Theme from the list, and by 8etetApply”, the theme can be
updated. Selecting “Delete” will delete the thenhefrom the “Memory Stick”.

217 -



Chapter 6: Custom Theme Creation Tool

This chapter describes a Custom Theme creation“®©@ostom Theme Converter
(hereafter, themeconv.exe)”.

Information Tab

The information tab requires inputting the follogimformation.

—iEix

File(E) Help(H)
Information |'I.I'I.I'a|||:uaper I Category Icons I First Level lcons I Second Level I 4 I "I

Title : |

Product 1D : I

Werzion : I

Information Content

Name

Title Title Information (Max 128 bytes, UTF-8
characters)

Product ID Product ID Code (Max 48 bytes)

Half-width Alphanumeric characters, hyphens ("-
"), and underscores ("_") can be used.

Version Theme Version (Max 8 bytes)
Combinations of three numbers, 0~99 each,
separated by periods (".")

For detailed usage information about the Infornrafiags, please see Chapter 7,
“Downloading with PSP”.

-18 -



Wallpaper Tab

The Wallpaper tab allows for specifying the filathvill be used as the Custom Theme’s
wallpaper. Push the Preview button to verify tHeced wallpaper. For files that can be
specified, see Chapter 3, “Image Sizes and Formats”

-19 -



Category Icons Tab

The Category Icon tab allows Category Icons todeei$ied. Icons can be previewed by
pressing the Preview button. For files that casecified, see Chapter 3, “Image Sizes
and Formats”.

If the “Default Icon” is specified, other icons thae not specified in this screen will
show using the “Default Icon”. If the “Default Icbis not specified, other icons that are
not specified in this screen will show using thegival PSP icons. For future updates,
additional icons will work in the same fashion.

-20 -



First Level Icons Tab

The First Level Icons tab is for selecting Firstzeelcons and their respective Icon Foci.
Pushing the Edit button will display the File Séiec window. Also, clicking the Clear

button will clear the selected files. Choosing Breview button allows the selected Icon
or Icon Focus to be verified. For files that carspecified, see Chapter 3, “Image Sizes

and Formats”.

If the “Default Icon” is specified, other icons thae not specified in this screen will
show using the “Default Icon”. If the “Default Icbis not specified, other icons that are
not specified in this screen will show using thegival PSP icons. For future updates,
additional icons will work in the same fashion.

-21 -



Second Level Icons Tab

The Second Level Icons tab is for selecting Seda@we| Icons and their respective Icon
Foci. Pushing the Edit button will display the F8election window. Also, clicking the
Clear button will clear the selected files. Chogdine Preview button allows the selected
Icon or Icon Focus to be verified. For files thahde specified, see Chapter 3, “Image
Sizes and Formats”.

If the “Default Icon” is specified, other icons thae not specified in this screen will
show using the “Default Icon”. If the “Default Icbis not specified, other icons that are
not specified in this screen will show using thegival PSP icons. For future updates,
additional icons will work in the same fashion.

-22 -



Others Tab

The Others tab allows for the Custom Theme’s Prevo®n, Preview Image, and Theme
Color to be specified. Pushing the Preview butitowe for the selected image file to be
verified. For files and theme colors that can becdped, see Chapter 3, “Image Sizes and
Formats”.

File Menu

The File Menu provides “New”, “Open”, and “Save tams for Custom Theme setting
information. Also, Custom Themes whose settingethsen completed can be exported
using the “Export” command.

Help Menu

The Help Menu allows themeconv.exe’s settings tmbdified.
The Settings menu allows the display language tchiosen, from English or Japanese.

-23 -



Chapter 7: Downloading with PSP

This chapter describes downloading Custom Thenmeewang the “PSP” Internet
Browser.

Meta Tag Information and Download Processing

The “PSP” Internet Browser’'s Custom Theme Downlhatttion refers to Meta Tag
information of the Custom Themes stored on a searet Custom Themes stored on a
“Memory Stick” inserted inside the “PSP” unit, andl automatically download the files
appropriately.

The Meta Tag information items that can be readréte, Product ID, and Theme
Version.

Title

The 128-byte UTF-8 title string (“title”) will beigplayed on the begin download
confirmation screen.

During display, long titles will be shortened ot@matically scroll. String lengths
that will not get shortened are roughly 20 charactker Japanese, Korean, and
Chinese, or 30 characters for other languages.

Product ID

The 48-byte Product ID string (“product_id”) wiletused as the filename of the
download.

With this, using a different Product ID for eacletie allows multiple themes to
be automatically downloaded using different filergsm

Theme Version

The 8-byte theme version string (“theme_versioni) ke displayed on the begin
download confirmation screen.

Also, this Theme Version is used to determine wéetin not to launch the
download. If a Custom Theme that has the same EBrd0us already saved on
the “Memory Stick”, the theme will only be downlctlif the Theme Version
indicates the theme is newer than the existing ®heme Versions are intended
to have three numbers between 0 and 99 each, sesparsaperiods, where larger
numbers indicate a newer theme version.

Examples
“1.00”
“1.1.1"
H1211

-24 -



“12.34.56"

“1.1” is newer than “1.00”
“1.10” is newer than “1.1”
“1.1.1” is newer than “1.1”

With this feature, if the Custom Theme data is dommerenewed, modifying the
Theme Version makes it such that only users whd tteenew data will
download it.

Placement on Server

To allow Custom Theme data to be downloaded usiagRSP” Internet
Browser”, a specific MIME-Type and file extensioust be used with the server.
The MIME-Type and file extension are defined below.

MIME-Type File extension
application/x-psp-theme ptf
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